Name:

TERMS AND SYMBOLS IN GEOMETRY
Chapter 1, Section 1 (p. 6 — 11)

Date:

Use your textbook to complete the charts below. DO NOT copy the descriptions/definitions
“word for word,” instead describe each in YOUR own words!

3 Undefined Terms in Geometry

Undefined Terms

Description Example How to Name It
(Description and Example)
Named using the
The smallest thing in word “Point” and the
POINT geometry. . . it has no ° letter next to the point.

sizel (Like a dot).

EX: Point A

2.
1.
0 0
E =
p Ho Go 2.
Definitions of Other Geometric Terms
Definition Example How to Name It

(Description and Example)

Segment
or
Line Segment

Ray




Other Important Definitions

Collinear points -

Noncollinear points -

Draw an example of each.

Collinear Points | Noncollinear
Points

1
Coplanar points -
Noncoplanar points -
Endpoint -

What two geometric figures have one or more endpoints? and
Initial point -
What geometric figure has an initial point?

Opposite rays -

Draw and label a pair of opposite rays:

Intersection -

Draw two lines whose intersection is point A:

1. First describe what each of these symbols represents. Second draw each figure.

a. PQ



2. Use the picture at right to decide whether the statement is frue or false.

a. Points A, B, and C are collinear

b. Points A, B, and C are coplanar. _ EI =
s o

c. Point F lies on DE .

- "
d. DE lies on plane DEF. AB_-L% |

e. @and ‘D_E— intersect.

f. BD is the intersection of the plane ABC and plane DEF.

3. Identify each as being best modeled by a point, line, or a plane.

a. astar b. a notebook cover
c. aruler edge d. the tip of a pen
e. a sheet of paper f. aletter opener

4. Tell whether each statement is true or false. If it is false, explain your reasoning.

a. Two planes intersect in only one point.

b. A ray starts at one point and goes on forever.

c. AB is the same segment as BA.

5. Use the picture at right to decide whether each statement is frue or false.
a. C, T, and B are collinear. |
b{ RSs the same as  RT.
c. C, T, and B name a plane.
d. R, T, and C are collinear.

e. Fourrays startatT.

HOMEWORK: p. 9—11(3-6,25-27, 31~ 34, 39, 40, 47, 49, and 50)



Name: Date:

POINT, LINE, and PLANE POSTULATES
Chapter 1, Section 1 (p. 6 - 11)

POSTULATE:

DIRECTIONS: Complete the following postulates with the word or words that you think
would make the statement true.

1. Through any 2 points there exists line.
2. A line contains at least ‘points.

3. If two lines intersect, then their intersection is exactly one

4. Through any 3 noncollinear points there exists
plane. |

5. A plane contains at least 3 ' points.

6. If two points lie on a plane, then the line containing them lies
the

7. If two planes intersect, then their intersection is a




PART 1: Use the pictures provided to help you answer each question. Use the cormrect
notation when writing your answers.

— —p
1. What is the intersection of PN and PQ?

— —
2. What is the intersection of NQ and PQ?

e <+
3. What is the intersection of RP and NP? N P Q

4. What is the intersection of plane ABE
and plane GFE?

5. What is the intersection of DC and CF?

6. What is the intersection of HG and plane
ADG?

G

PART 2: Name all the sets of points in each figure below that are collinear and three points
that are noncollinear.

7. 7 8.
R
N P Q
Collinear points: Collinear points:
3 noncollinear points: 3 noncollinear points:

PART 3: Use the figure at right to answer each problem below.
9. Name three points that determine plane R.
10. Name the intersection of plane R and plane M.

11. Name the intersection of line / and line k.

12. How many planes contain points B, D, and E?

13. How many planes contain points G, E, and F?

14. If line k is contained on plane M, then what
points must be contained in plane M?




Name: Date:

SECTION 1.2 -> MEASURING SEGMENTS

What is the meaning of AB 2 What is the meaning of AB?

RULER POSTULATE: If points A and B are located on a NUMBER LINE, then . . .

A B AB:fx2~x1[

2 where x; and x; are the coordinates of A and B
EXAMPLE 1: EXAMPLE 2:
Q R W X
-—o———————o—p o P
3 12 -12 7
QR = =

SEGMENT ADDITION POSTULATE:

1) You can add the lengths of two (or more) small segments to find the length of the larger
segment.

2) If B is between A and C, then AB + BC = AC.

O

—0

A B Cc

EXAMPLE 1: EXAMPLE 2:
15¢cm 7cm X 2x+1

o O—
Q R S w X Y

10

QS = Find x and then find XY.



CONGRUENT SEGMENTS: Segments that have the SAME or EQUAL LENGTH.

** The symbol for congruent is — .

** To show that segments are congruent, we use tick marks.

*If 4B =CD. then AB = CD.

MIDPOINT: A point that divides a segment into two — segments.

— | |

EX: { J ] | | Jis the midpoint of HI if . . .

SEGMENT BISECTOR: A geometric figure that divides a segment into two congruent parts,

EX:
o XO bisects WY
. | ; - OR
w | /< | Y XO is a segment bisector
EXAMPLE #1: EXAMPLE #2:
F is the midpoint of EG. Find x R is the midpoint of @ . Find x. Find 5Q,
E  20om F ix-8 G B SETD T
Q R S
EXAMPLE #3: | EXAMPLE #4:
BD bisects AC . Findx: BD bisects AC , Find AC.
D D
3x?+x+2/ 5x2_2x_3

o

B 31 C . ’/3 c
_ 20em —

B9



Name: ' Date:

FINDING THE LENGTH OF SEGMENTS WITHOUT USING A RULER
Chapter 1, Section 2 (p. 13— 19)

PART 1: FINDING THE LENGTH OF SEGMENTS USING A NUMBER LINE.

A B C D E F G H I J
*%W. -O——r —C—
-50 -35927 -12 60 5 13 25 32 50
1. EG = 2. 1IG= 3. HD = 4. BG= 5. AC= 6. BD =

7 8
A B C D E F
————o———— B -
16 g 27
AC= IfDF = 58 units,
then DE =
9 10. R
& I e ! R s T
O — O —————0 -
X x> - -
If GI = 60 units, v PRERE e
then x = ¢ Sisthe mi'dpomt of RT
* QR =4 units
e ST =5 units
RS = RT =
PR = PQ=
11. F 12. Point R lies between S & T.
° = e ST =79 units
H e RS= 4y -1

D e RT=7y+3

e Eis the midpoint of DF

s DE=5x+3
e EF=33 RS = RT =




13. Given: BD exceeds CE by 10. 14.

- 2x+6 3x-3 4x - 11
(HINT: This means that B0 is longer than CE)). 5 Q H
2x 4% -3 3X 2x+ 3 . . ) S
o - — 5 A. If R is the midpoint of QS, what are-
A B G D E

PQ:_____ QRZ_____ RS =

—_——

A. What is the length of (E)F?
B. Which is longer,A_C or CE?
C. What is the total length of AE?

B. If PR=QS, what are:
PQ = QR = RS

15. Find x. 16. Find x.
i 24—
X+5 2x~1 2x x+1 4 -7
A c B A D c T B

17. Find x and then find BD.

Bx® 2201

x2_2 6-2x




Name: Date:
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SECTION 1.3 — ANGLES AND THEIR MEASURES

Angle:

- Interior of an angle:

- Exterior of an angle:

3 Ways to Name an Angle

1.

Measuring an Angle

* The measure of an angle is found using a

* Angles are measured in

* The measure of ZA is denoted by

CONGRUENT ANGLES:

ANGLE ADDITION POSTULATE:



Types of Angles

1. Acute Angle:
2. Right Angle:
3. Obtuse Angle:
4. Straight Angle:

5. Adjacent Angles:

Angle Bisector: 3

EXAMPLES: 1
1. Name all the angles in the diagram at right. /Q}
M
x

2. Ifm£BOC =22° and m/BOD = 50°, then 3. m£Kl = (2x + 6)°, msHIJ = (8x - 4)°,
what is the measure of ~COD? and mzKIH = 62°. Find m<KlJ & m2HIJ.
A
g K
S f
o = H ’

- 2 acute angles: - 1 right angle:
- 2 obtuse angle: - 1 straight angle:

- 1 pair of adjacent angles:




Name: _ Date:

Angles and Their Measures
Chapter 1, Section 3

PART 1: Use the Angle Addition Postulate to answer the following questions.

4. msGFl = 5. If mZGFIl =93°, what is 6. If mZCED = 39°, what is
mZGFH? m/CEL?
A
G - c
103 o G
39 H b L
E i 46 E X+ 25
F | D
7. _
msFUR = mZ0OUT =
msTUE = m<sEUR =
LTUE =/ m<ZRUN =

m«NUF = mZFUE =

8. m£CBE =80°. Find m£ABF.

9. mZIGH = (2x + 5)°, m£FGH = (13x =3)°,
and mZIGF = 62°. Find the value of x.

10. m«£DBC = (2x + 10)°, m£ABC = (5x —3)°,
and mZDBA = 70°. Find m«DBC and
m<ZABC.



11. Qs on the interior of ZROS. Sis on the interior of #QOP. Pis on the interior of ZSOT.
M£LROT = 127°, msSOT = 71°, and m£ROQ = mZQOS = msTOP. Make a sketch and

answer the following.

a. Find m-QoOPpP b. Find m<QOT ¢. Find mZROQ d. Find msSOp
12. KM bisects /JKL. 13. BD bisects ZABC.
M£JKM = (3x + 12)° MZABD = (4x + 6)°
msMKL = 41° : m£DBC = (7x — 12)°
Find x. Find x.
Find m~-ABC.

PART 2: REVIEW OF THE SEGMENT ADDITION POSTULATE. Use the Segment Addition
Postulate to answer the following questions.

14. Let A be between B and C. Solve forp, 15. Let F be between G and H. Find the

given the following information. length of all three segments, given the
BA=4p-18 - following information.
AC=6p—12 GF =6n-45
BC =40 FH=7n-30

GH=2n+46



Name: Date:

Sections 1.1 to 1.3 Practice

PART 1: SEGMENT AND ANGLE BISECTORS. In each problem below, B is the midpoint of 4C
or BD bisects Z/ABC. Find the specified value or length.

1. Find AC. 2. Find x. 3. Find AC.
3cm 10 cm 2x + 4 5x 3x+2
[, ] O — o} o— O —0
A B C A B c A B 2
4. Find mZABC. 5. Find mzABD.
A A
D D
22 9
B .
B
7. Find x. 8. Find x.

Turn over -



PART 2: Answer each of the following review questions.

9. Name three points that are collinear. A. Points T, Q,and S

B. PQints S, Q,and R
C. Points T, Q, and R
D. Points T, S, and R
A B. C. D.
; i P Q R P Q R P Q R R Q p

11. The notation for the length of a segment between ‘P and Qis "

A. QP B. PQ C. PQ D. PQ

12, If AB =13 and AC = 27, what is BC?

- o—— P
A B . C

13. fm£FOH = 58° and m~<FOG = 30°, then what is m/GOH?

F

14. If F is between G and H, GF = 5x + 28, FH =7x + 20, and GH = 48 cm, what is the value of x?

15. m£ZHFG = (2x + 6)°, mZEFG = (12x — 1)°, and mZHFE = 61°. What is msLEFG?



Name: : - Date:

More Practice with Midpoints and Bisectors

DIRECTIONS: Use the given information and pictures to solve each problem below. Show your
work. Circle your final answers.

1. BDbisects ZABC. 2. Q is the midpoint of PR. 3. I bisects AC .

Find x. p Find x. Find x. l
12
B
P Q R A B c
2x+3 5x-7 / 14 -x
v
4. XZ bisects ZYXW. 5. BDbisects ZARC. 6. E is the midpoint of DF.
Find x. . MZABC = 4x+12. Find DF.
1?22 Findx. A D E E
5x-7 T 4x+2
‘ﬁm 10 B
X7
3x+ 3
C
» ]
)
7. Eé bisects ~/DEF. ‘8. Is B the m!dpomt'? 9. mZQRS =42¢°,
Find m~DEF. 16 Does RT bisect #QRS?
N A B c  q / |
3x-6 2x+12
/3x+ 6 T
R 4x+1
S
10. B is the midpoint of AC. 11. BDbisects ~ABC.
Find x. A B C Find x.

Find AC.

x*+3x 2x+6




Name: Date:

—_—

SECTION 1.4 — PAIRS OF ANGLES
(p. 28— 33)

DEFINITIONS

1) COMPLEMENTARY ANGLES —

COMPLERMENTS -

2) SUPPLEMENTARY ANGLES —

SUPPLEMENTS -

3) LINEAR PAIRS -

EX: £1 and £2 are linear pairs
£2 and /3 are linear pairs
£3 and £4 are linear pairs
£4 and £1 are linear pairs

LINEAR PAIRS POSTULATE —

4) VERTICAL ANGLES —

EX: £1 and £3 are vertical angles
42 and /4 are vertical angles

|
VERTICAL ANGLE THEOREM —




PRACTICE PROBLEMS

1) /’

3x+5/+15
—

v+ 20 4y - 15

A

3. m£ZA = 50°
m«£B = 19°
m«£C = 110°

d.
e.

f. What is the measure of the supplement of /C?

. What is the measure of the complement of ZA?

Are Z2 and £3 linear pairs? Why or why not?

- Are Z3 and /4 linear pairs? Why or why not?

Are Z1 and 23 vertical angles? Why or why not?

What is the value of x?

What is the value of y?

What is the measure of the supplement of ZA?
What is the measure of the complement of #B?
What is the measure of the supplement of /B?

What is the measure of the complement of ZC?

4. ZA and /B are complementary angles. m~A = 5x + 8 and m£B = x + 4. Find the measure of

each angle.

5. ZT and £8 are supplementary angles. mAT is half the measure of /S. Find the measures of

each angle.



Name

Date
Section 1.5 — Area Notes
Square Rectangle Triangle Circle
| i
.
e S el ooe — —_ W
d
| H
! {
s = side [ = length h = height d = diameter
w = width b = base r = radius
Area =g Area=1w Area = ( ¥2)bh Area = nir?
Perimeter = 4s Perimeter = 2] + 2w Circumference = nd = 2nr

1. Fill-In the Blank:

1. The perimeter is the distance a figure.

2. The circumference is the distance around a

3. The is the number of square unties needed to cover the figure.

I1. Find the Perimeter:

4, T —— 6 in. 5. Y]

— 4 cm

124

11



I11. Find the Circumference:

3cm.
9 10.
C=
IV. Find the Area:
] ||
12. 13.
L] ]

6 ft

“Throw-Backs” Recall previous knowledge.

V1. Classify each angle as Acute, Obtuse, Right or Straight:

1LY

B 15. - ABC
) £ 16. < BAC
17. - BCA
. 18. - DEF
C
g ° 19. - EFG
“ 20. - EDG
21. -~ DGF
22. =~ JKM
J ‘ L 23. ~ KML
! 24, . ML
VL Fill-In the Blank:
25. An angle measures between 0" and 90"
26. A right angle measures exactly
27. An obtuse angle measures between and
28. A angle measures exactly 180"

Additional Practice: Textbook pg. 38 #10-21

12in

13 in



Name: Date:

CHAPTER 1 REVIEW

Terminology, Rules, and Other Things You Should Know

3 Undefined Terms in Geometry Acute Angle Vertical Angles

Ray Obtuse Angle Vertex

Segment Right Angle Intersection

Angle Straight Angle Congruent e
Bisector Adjacent Angles Complementary
Midpoint Linear Pairs Supplementary

Angle and Segment Addition Postulates Collinear and Noncollinear Coplanar

Distance between point on a # Line Area formulas Postulate

How to name geometric figures

-_._.._____._.._..__..._._._______.___.-..._.__-_.____.__..._....__....._._._-..__......__._-.-___-__.__._‘.__, 2

Format of Test
Worth a Total of ‘74 Points.
43 Questions
Multiple-Choice Always, Sometimes, or Never
True/False Short Answer Math Problems involving segments and /s

Practice Probfems

Use this diagram
to answer #1 — 3. )
1. Which angles form a linear pair?

A. Z1and 22 B. Z1and 24 C. 22 and .;3 D. £3and /5 E. z4 and /5
2. Which angles are vertical angles?
A. Z1and £2 B. £1and z4 C. £2and «3 D. z3and 45 E. z4 and /5
3. Which-angles are supplementary?

A. Z/1and 24 B. “4and /5 C. Z1and »£5 D. BothBandC E. All of these

4. Two angles are complementary. One angle has a measure that is twice the other angle. What is
the measure of the larger angle?

5. Using the figure at the right, find the value of y.

6. Find the area of the figure at right.




7. BDbisects ~ABC. Find the value of x, 8. BDbisects ZABC. Find the value of x.

Aj‘f D‘
; :j{ D H‘I’srﬂ; \’;?‘r—-.,,_w_ﬁA‘%r-h 2)( - 24 ;?
*ﬂ» f 3x-12
= R S
T
9. Use the diagram at right to complete each statement.
A Ifms1 = 37°, then m.2 = .
B. fms4 =72° andms5 = 43°, then ms1 = }
C. IfM£2=m/6 = x°, then m3 = . '
10. Find the value of x and V.
X=___
= "

11. Inthe figure at right, m-MAN = I7x+3, MZMAL = 9(x-3), and moNAL = 3(7x+2).

A. Find x. /

B. Find m<MAN.
C. Find msNAL. N
A
12. IfDE = 91, find the indicated values.
X-4 2x+5

A x= - — i PE A

B. DC=

C. CE=
Answers fo Practice/Review Problems

1. E 7. 17

2. B 8. 38

3.D 9. a. 37° b. B65¢ c. 180-2x

4. 60° 10. x=10 y=20

5. 285 i1. a. 6 b. 105° c. 132¢°

6. 12 yg? 12. 2. 30 b. 26 units c. 65 units



introducing Points, Segments, Rays, and Lines

In this activity you'll experiment with drawing, dragging, measuring, and labeling

points, segments, rays, and lines. These objects, along with circles, are the building

blocks of most geometric constructions.

SKETCH AND INVESTIGATE: POINTS AND SEGMENTS

By default, point labels
start with A

Note: If at any time you think you’ve made a mistake or you want to do something

differently, you can always undo as many steps as you like. The Undo and Redo

commands are in the Edit menu.

L

al

a2

10.

. Drag one of the points and observe the measurement. Al B

. Choose the Segment tool and draw a segment

Choose the Point tool and click in the sketch to construct o &)
a point. Click again to construct a second point. Notice
that the most recently constructed point is selected: It appears with an outline.

. Choose the Selection Arrow tool and click in a blank area in the sketch. This

deselects everything.

. Choose the Text tool. Position the finger over a point, A B

then click to display that point’s label. Display the other A
point’s label, too.

. With the Selection Arrow tool, click on both points. A B

Now both points should be selected.

. In the Measure menu, choose Distance. AB = 272 cm

How can you make the distance between the two points zero?

connecting the two points. You'll see a triple segment Qﬂ
at first, indicating that the segment is selected. A

. With the segment selected, go to the Measure menu

and choose Length.

. Use the Selection Arrow tool to drag either endpoint of the segment.

How does the length of a segment compare to the distance between
its endpoints?

Use the Segment tool to construct a second segment G

with one endpoint attached to the first segment. To do

this, click the mouse button first when the pointer is in B
a blank area of the sketch, then when it’s directly on the A
original segment.

© 2008 Key Curriculum Press



Introducing Points, Segments, Rays, and Lines

continued

11.
12.

13.

14.
15;
16.

17.

18.
19.
20.

Use the Text tool to show the labels of this segment’s endpoints.

Use the Selection Arrow tool to drag point D to confirm that it is attached
to AB.

Select CD (the segment, not its endpoints), then go to the Construct menu and
notice what choices are available. Choose Midpoint. C

Click in a blank area to deselect everything.
Select point D. B

In the Edit menu, drag to the Action Buttons
submenu and choose Animation. You'll get a

dialog box you can use to specify animation
settings. To choose the default settings,
click OK. You've created an Animation B

a

action button in your sketch. A

Press the action button (by clicking on it) to
start the animation.

Press the button again to stop the animation.
Select the midpoint; then, in the Display menu, choose Trace Midpoint.

Press the Animation button again and observe the path that the midpoint traces.

a3 Describe the path that the midpoint traces as point D moves back and forth.

SKETCH AND INVESTIGATE: RAYS AND LINES

21.
ALAL 2

2.3

24.

25.

In the File menu, choose New Sketch.

Press and hold down the mouse button on the Segment tool. A palette of
Straightedge tools will pop out to the right. Drag right and choose the Ray tool.

Draw a ray in your sketch. Notice that the ray 5
extends in one direction beyond the edge of your

sketch window.

Use the Text tool to show the labels of the ray’s
control points.

Use the Selection Arrow tool to drag each point to observe how it controls
the ray.

04 A ray with endpoint A that passes through a point Bis called ray AB

(represented symbolically as ARB). Could it also be called ray BA? Explain.

© 2008 Key Curriculum Press



Intreducing Points, Segments, Rays, and Lines
continued

26. Select the ray and go to the Measure menu. Note that Length is grayed out.
@5 Why do you think you can’t measure the length of a ray?

27. With the ray still selected, go to the Construct

menu and look at your choices. Choose Point
On Ray. :

06 Why can’t you construct the midpoint of

a ray? &

28. Drag this new point to see how its behavior compares to that of the ray’s two
control points.

@7 Give two different names to the ray shown at A
right.Use just two points in each name. € 5

29. Press and hold down the Ray tool, then drag right to
choose the Line tool.

30. Experiment with drawing lines in your sketch.

@8 List all the similarities and differences you can between segments, rays,
and lines.

@9 Name two rays and a segment that lie on the line below.

A B

D PR o

@10 In Sketchpad, construct a line without using the Line tool. Explain what you
did. Does your line remain a line when you drag points?

© 2008 Key Cuniculum Press



Geometry CP

Coordinate Geometry

(Sections 1.6, 3.5, 3.6)



Name Date

1.6 Notes: Distance and Midpoints in the Coordinate Plane (p.43-49)

Objectives:
Find the coordinates of the midpoint of a segment in the coordinate plane, using the Midpoint Formula.
Use the Distance Formula to find the distance between two points in the coordinate plane.

The is a plane divided into four regions by a
horizontal line and a vertical line. The four regions are called . The horizontal line is known
as the , and the vertical line is known as the . The location, or

. of a point are given by an ordered pair ( %

Use the coordinate plane to label the vocabulary and plot the following points.

LABEL THE COORDINATE i PLOTTING POINTS:
PLANE:
’ A(-2,5)

Quadrant I Quadrant II - 5 B(9, -7
Quadrant ITI  Quadrant IV ; C(4,2)
origin X-axis : D(-1,-8)
y-axis ! E(0,5)

-12 -1 -10 -2 -8 -7 -6 .5 -4 3 . E » 2 1 5 T 0 11 12 F ( _3 R 0 )
DISTANCE FORMULA:

The distance formula is used to calculate the distance between two points in a coordinate plane.

The distance between two points (x,,y,)and (x,,y,) can found by

A
d= \/(xz _x1)2 +(y, —yl)z
4
a) A(0,3) and B(5,1). Find AB, b) C(-1,1) and D(-3,-4). Find CD. A p 2 \"\,ﬁ




MIDPOINT FORMULA:

You can find the midpoint of a segment in a coordinate plane by using the coordinates of the endpoints.
Calculate the average of the x-coordinates and the y-coordinates.

The midpoint M of AB with endpoints A (x,,y,)and B (x,, y,) can be found by

Mx2+x1 Vot Y
2 ' B

¢) Find the coordinates of the midpoint of EF with endpoints E(-2,3) and F(5.-3).

d) M is the midpoint of JK . J has coordinates (2,2), and M has coordinates (4 , -3). Find the coordinates of K.

Practice: \ t ? Ay EEE
_ ‘ - 2

1. Find AB. : | | -

2. Find the coordinates of the midpoint of EF . 1] NG g

_____ YN

On the map, each square of the grid represents 1 square mile. Find each distance to the nearest tenth of a mile.

3. Find the distance along Highway 201from Cedar City to Milltown. N -
.......... ; 4 1
4. A car breaks down on Route 1, at the midpoint between Jefferson and Milltown. i RN
A tow truck is sent out from Jefferson. How far does the truck travel to reach W ENEN
the car? <t RIOU%E :10“
jef.férson L
Highway 201F
K TR S . )

s Milltown



Name

Date

Distance and Midpoint Formula Practice

Directions: Find the Distance between the two points.

1. \‘-

3 (3,8). (9, 10)
Directions: Find the Midpoint between the two
points. Use the graph to check your answer.

5.

4. (-8, 10), (-6.7)

8. (-1.-6). (-6, 5)




14,

Directions: Find the OTHER ENDPOINT of the line
segment with the given endpoint and midpoint

Endpoint: (=1, 9). midpoint: (=9, —10} 10.  Eadpoint: (2. 5). midpoint: (5. 1)

Critical thinking:

On a map, with scale of 1unit = 3.5 miles, the coordinates of John’s
house are (-2,-8) . The coordinates of Paul’s house are (1, -2).
Paul’s house is the midpoint between John’s house and the library.

How many MILES does Paul live from the Library?




Name Date

3.5 Notes: Slopes of Lines (p.182-187)

Objectives:
Find the slope of a line.
Use the slopes to identify parallel and perpendicular lines.

The of a line is a number that describes the steepness of the line. The slope of a line is

the ratio of over . Any two points on a line can be used to

calculate the slope of the line containing those points.

The rise is the difference in the of two points on a line.
The run is the difference in the of two points on a line.
SLOPE FORMULA:
If 7(x, »,) and P,(x, y,)are two points on a line, then the slope, m, of the line is calculated by the formula:
it = Y2 — N
X, =%

CALCULATING SLOPE: Find the slope of the indicated lines.

| 17 - i
i | i .
B By IR a) AB b) CD
| AL sl
o | /;,/7
R LT e
+ ¥ 'S
1 VH irl - ,—/;’}M"- -!7; ,,l,, 2 4 : ,? | ]U|7|7
éé pal y - c) BEF d GH
. 7
" i
1z !

Positive Slope Negative Slope Zero Slope Undefined Slope

y le ]y y
X \ X X X
“ N » e R
AN |




Application: Rate of Change in Miles per Hour (mph)
Tony is driving from Dallas, Texas to Atlanta, Georgia. At 3:00pm, he is 180 miles from Dallas. At 5:30pm, he is
330 miles from Dallas. Find and interpret the slope of the line.

Distance from Dallas
a) What was Tony’s average speed in miles per hour.

(55, 330) 7 |
fgggg 1 T
= 240
§ 180 3, ";mj,"
& /
b) If Tony’s average speed stay the same, how far will he have traveled by 6:30pm. . 122 /)
/ i
o 123456
Time (h)
SLOPES OF PARALLEL AND PERPENDICULAR LINES:
PARALLEL LINES THEOREM: Parallel lines have the slope.
e Any two vertical lines are
e Any two horizontal lines are
PERPENDICULAR LINES THEOREM:
Perpendicular lines have slopes.
o and lines are perpendicular.

DETERMINING IF LINES ARE PARALLEL, PERPENDICULAR OR NEITHER.
Use the slopes of the lines to determine if the lines are parallel, perpendicular or neither.

a) E and CT) b) S-—7:and W

¢) FG and HJ d) WX and YZ for W(3,1),X(3-2).

Y(-2,3),and Z( 4,3 )

HW: p.186 # 10-22
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Finding Slope From a Graph Date Period____

Find the slope of each line.

1) N 2) N

- ot ? LA

S
A 4

v

3) 4)

A 4

5) 6)

b
.
Vv
N N 8) ~
€ > < g >
W v




Name

Date

3.6 Graphing Lines in the Coordinate Plane (p.190-197)

jectives: Graph lines in the coordinate plane.

Find the equation of a line given a point and a slope.

Find the equation of a line given two points.

Torms of the Equation of a Line

Slope-Intercept Form

y=mx+b

Equation of a line with slope
m and y-intercept b.

Point-Slope Form

(y=y)=m(x—x)

The equation of a line passing
through the point (x,,y,) with
slope m.

@) Horizontal Li
c%é orizonta mes

y=b

* Example: y = -3

Where b is the y-intercept.
Slope of a horizontal line = 0

Lo
= Vertical Lines

X=a

* Example: x =2

Where a is the x-intercept.
Slope of a vertical line is
undefined.

Graphing Lines in the Coordinate Plane:

» graph linear equations on the coordinate plane:
1. Rewrite the equation of the line in Slope-Intercept Form.
2. Plot the y-intercept, b on the coordinate plane.
3. TFrom the y-intercept, use the slope to find additional points on that line.

Example: Graph y = zx +3

The equation is given in slope-intercept form,

with a slope {)f{% and a y-intercept of 3.

Plot the point (0, 3) and then rise 3 and
run ! to find another point.
Draw the line containing the two points.

Try these:
Graph the lines on the coordinate plane.

1
A =—x-2
)y >

B) x=-3

~

iAo




Writing the Equation of a Line in Slope-Intercept Form:

e  When given a point (x,,y,) thru which a line passes and the slope m of the line, use the Point-Slope
Form to find the equation of that line. Solve for y to write the equation in Slope-Intercept Form.

Example: Write the equation of the line passing thru (-2, 1 ) with a slope of 3.

e  When given two points (x,,y,)and (x,,y,). first find the slope of the line passing thru those points.

Then using the slope and one of the points, use the Point-Slope Form to find the equation of the line.
Solve for y to write the equation in Slope-Intercept Form.

Example: Write the equation of a line passing thru the points ( 8,-3 ) and ( -5, -7).

Try These:

Write the equation of the line passing thru ( -5, 2 ) with a slope of — % g

Write the equation of the line passing thru ( 4 , -6 ) with a slope of 0.

Write the equation of a line passing thru the points (4, -1) and ( -1, -1).

Write the equation of a line passing thru the points ( 6, -8 ) and ( 6,2).



Using the Graphing Calculator to Solve an Application:

Problem-Solving Application

Audrey is trying to decide between
two health club plans. After how

many months would both plans’

total costs be the same?

Plan A
Enrollment Fee | $140
Monthly Fee $35

35x + 140
55x 4+ 60

PlanA: y=
PlanB: y=

HW:
Graph the following lines on the coordinate plane.

L) y=8

3
2) y=—"-7
)y 2

3) y=5x-2
4} x=-9

5)3x+2y=8

) 12x-6y =36

»



Write the equation of the lines in slope-intercept form. Graph and label the lines on the coordinate plane.

7.) Write the equation of line / passing thru ( -8, -3 ) with a slope of — ;

8.) Write the equation of line m passing thru (5, 9 ) with an undefined slope.

9.) Write the equation of a line passing thru the points A( 7,5 ) and B( -2, -4 ).

10.) Write the equation of a line passing thru o N
the points C( -1, -3 ) and D( 6, -3 ). : -
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Graphing Lines Date Period

Sketch the graph of each line.

1 2) y=—5x-1
1) y:~§x~2 )y *

2

M
A 4

-6-5-4-3-2-10] 1 2 3 4 5 6 Y

5 4) y=—Tx+3
B F=gh =

W

123456

A4

4 | i
SRR SR SN S NN U I U YR SO O S N S SN SO N |
2 ..... | 2
¢ > < >
—-6-5-4-3-2-10] 1 2 3 4 5 6 -6-5-4-3-2-10f 1 2 3 4 5 6 7
....... 2] -




1
7)) v=——x+4
) 3

M

6-5-4-3-2-10] 1

h 4

N

-6 -5 -4-3 -2 -

W

8) y=0

£
~

-6 -5 —4-3-2-10

10) y=T7x-35

v

N

=54 -8 210

123456

h 4

4icd

W
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Writing Linear Equations Date

Write the slope-intercept form of the equation of each line.

1) 3x-2y=-16 2) 13x—11y=-12
3) 9x=Ty==7 4) x-3y=6
5) 6x+5y=-15 0) dx—y=1
7 1lx—4y=32 8) 11x—8y=-48

Write the standard form of the equation of the line through the given point with the given slope.

9) through: (1, 2), slope=7 10) through: (3, -1), slope=-1

11) through: (-2, 5), slope = -4

12) through: (3, 5), slope :%

Period



13) through: (2, —4), slope =-1 14) through: (2, 5), slope = undefined

1 16) through: (-1, 2), slope =2
15) through: (3, 1), slope:-i— ) through: (-1, 2), slope

Write the point-slope form of the equation of the line described.

: 7
17) rough: (2], pardllelis yo==ppe=g 18) through: (=3, -3), parallel to y=—x + 3

3 20) through: (-1, 4), llel to y=—5x+2
19) through: (-4, 0), parallel to y.:zx_z ) through: ( ), parallel to y X

1 22) through: (4, —4), parallel to y = —x — 4
21) through: (2, 0), parallel to y:§x+3 ) through: ( ), parallel to y=—x

i 1
23) through: (=2, 4), parallel to y=~"x+5 24) through: (~4, -1), parallelto y=~—x~1



